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Abstract— Packet sniffing is a strategy for tapping every 

packet as it streams over the network; i.e., it is a procedure 

where a end users sniffs information that is of different users 

on the network. Packet sniffers can work as an authoritative 

tool or for pernicious purposes. It relies upon the end users 

purpose. Organization administration use them for checking 

and approving organization network traffic. Packet sniffers 

are simple applications. There are programs used to catch 

packets that traverse the organization network layer 

(TCP/IP). (Essentially, the packets are recovered from the 

organizations network layer and the information is 

deciphered.) Packet sniffers are utilities that can be 

effectively utilized for network administration. 

Simultaneously, it can likewise be utilized for detestable 

exercises. Notwithstanding, a client can utilize various 

methods to distinguish sniffers on the network and shield the 

information from sniffers. 
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I. INTRODUCTION 

A Sniffer is a tool that captures data over an network. At the 

point when any information must be sent over from the 

network from one computer to other, it is fragmented into 

more units at the sender's hub called data packets and 

reassembled at receiver's hub in correct format as it was sent 

from the senders hub. It is the littlest unit of communication 

over a network. It is additionally called a block, a datagram. 

The demonstration of catching information packet over the 

computer network is called packet sniffing. It is like as wire 

tapping to a network. It is generally utilized by hackers and 

programmers to gather data illicitly about network.  

There are 2 kinds of Sniffers: Business Sniffers and 

programed Sniffers. 

1) Business Sniffers –  

Business sniffers are utilized to keep up and screen data 

over the network. These sniffers are utilized to recognize 

network issues. there are organizations that offers business 

sniffers. These can be utilized for:  

 Flaw examination to identify issues in an network.  

 performance examination to recognize network 

bottlenecks.  

2) Programed Sniffers –  

programed sniffers are malevolent programs utilized by 

hackers to catch data over a network. when an underground 

sniffers put on routers, it can break security of any network 

that goes through the routers. It can catch: 

 Classified messages like email.  

 Money related information like credit card information.  

 Segments of a Sniffer:  

To catch the data over the network sniffer utilizes the 

accompanying segments:  

 hardware Equipment –  

Sniffers utilizes standard network connectors to catch 

network traffic.  

 Capture Driver –  

Capture Driver catches network traffic from Ethernet wire, 

refine that network traffic for data that you need and 

afterward stores the refined data in a buffer.  

 buffer–  

At the point when a sniffer catches information from an 

network, it stores information in a buffer. There are 2 

different ways to store caught information .You can store 

information until buffer is loaded up with data  

It is the round robin strategy in which information in the 

buffer is constantly removed and placed by new information 

that is caught.  

 Decoder –  

The data that moves on the network is in binary format, 

which isn't readable. you can utilize a decoder to decipher 

this data and show it in readable format. A decoder 

encourages you break down how data is passed from one 

system to other.  

placing of Sniffer:  

The most widely spots where you can put sniffers are:  

 PC  

 network wires  

 routers 

 network fragments associated with internet. 

II. HOW IS PACKET SNIFFERS USED? 

It is mostly utilized by ISPs, publicists , governments and 

corporate organnizations:. 

 ISPs use packet sniffing to follow every one of your 

activities on the internet, for example,  

 who is sender of your email  

 what is attachments of that email  

 your downloads  

 websites you visit  

 what you looked on website  

 downloads from a webpage  

 streaming functions like video, sound, and so forth  

 Publicizing organizations or web promoting offices are 

paid by:  

 number of advertisements appeared.  

 number of clicks on their advertisements likewise called 

PPC (pay per click).  

To accomplish this objective, these offices use 

packet sniffing to infuse commercials into the streaming 

packets. More often these advertisements contain malware.  

 Government offices and corporate organizations use 

packet sniffing to:  

 guarantee security of information over the organization.  

 track an association's decoded information. 

 Keep track of employees activities 
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III. HOW DOES A PACKET SNIFFER WORKS 

Packet sniffers works on a simple concept of capturing and 

logging network traffic through wired or wireless network 

interface that the packet sniffing tool can access on its host 

system.  

On wired network, the data that can be caught 

relies upon the type of the network. A packet sniffer user 

can choose to see all the traffic on the network or the 

specific part of the network, contingent upon how the 

network switches are designed. On wireless networks, 

packet sniffers can typically catch one channel at a time 

until the host PC has different wireless interfaces that 

consider multichannel catch.  

When the packet information is caught, the packet 

sniffing tool dissects it and presents it in readable structure 

with the goal that the individual utilizing the tool can sort 

out it. The individual examining the information can see 

details of the communication between at least two points on 

the network. network administrators professionals utilize 

this data to analyze o where a flaw lies, for example, finding 

out which system did not respond to an network request.  

hackers use sniffers to listen in on decoded 

information in the packets to perceive what data is being 

traded between two users. They can likewise catch data, for 

example, passwords and verification tokens if they are sent 

without any encryption through the network. hackers are 

additionally known to catch packets for later playback in 

replay, man-in-the-center, and bundle injection attacks that a 

few computers are defenseless against. 

few application sniffers and network packet 

analyzers work by  making the network card into 

unrestricted mode. In ordinary mode, the network card will 

gather just packets routed to its MAC Address. At the point 

when the unrestricted mode is enacted, the network card 

gathers all packets on a similar network portion. The packet 

sniffers main use is that they can "see" the network traffic 

not only from the one system, but from all the systems on 

the same network. The only detriment of such packet sniffer 

is that it can't decrypt the SSL traffic without recovering the 

server certificate.  

Another process for capturing the network traffic is 

introducing a driver on the system where the packet analyzer 

is working at. This restricts the network packet analyzer to 

just to the host's system however gives a capacity to decrypt 

the SSL traffic by utilizing  Man-in-the-middle. 

IV. BENEFITS OF THE PACKET SNIFFER TOOL 

A. Finding the root cause in the network 

Guaranteeing all applications and servers perform with no 

performance lags is a tremendous undertaking. At the point 

when an application or an services encounters an issue, it 

very well may be a troublesome errand to recognize which 

network or application segment is answerable for the lag. 

This is the reason network administrators keep monitoring 

network persistently for routine support and improvement. 

With packet sniffers, they can gather data from all nodes of 

their network to rapidly distinguish the parts answerable for 

inactivity or packet loss. 

B. Troubleshooting Network problems 

When IT team receives problems related to network 

connectivity, they use PCAP analysis to find the response 

time in the network .which then helps in finding out the 

amount of time taken by a packet to travel from one node to 

other node in the network. With the help of the analysis the 

IT team can find congested links find which applications are 

generating unusual amount of traffic, take action against the 

problem and resolve them. Modern wifi packet sniffers can 

help to get the performance metrics for different access 

points and wireless controllers. 

C. Analysis of the traffic on the network 

IT teams can also collect packet data for further analysis. 

With the help of the data we can analyze the network 

demand  over longer periods Utilizing advanced IP sniffers 

and packet analyzers, they can arrange the information 

dependent on destination server IP addresses, ports 

associated with correspondence, the volume of traffic, and 

more. With this analysis, it's conceivable to recognize 

critical traffic (needed for VOIP, ERP suites, CRMs, and so 

on) from non-business traffic (web-based media, 

unapproved couriers, and so on) Additionally, IT managers 

can filter and flag suspicious content. 

D. Improve Management of bandwidth  

Slow or irregular networks can fundamentally affect 

business profitability and lead to colossal misfortunes. 

network depend on advanced network monitoring tools to 

keep away from such issues. Be that as it may, the greater 

part of these tools additionally depend on packet sniffing to 

examine the traffic in an network. Packet sniffers help in 

forestalling the abuse of the network by both internal and 

external end users. As examined above, with traffic analysis, 

IT teams can without much of a stretch recognize the traffic 

flow and WAN bandwidth capacity use, any unpredictable 

increment in network use, and more. with this information, 

they can manage bandwidth capacity for crucial 

applications, and even restrict certain applications. 

E. Improve Network security and consistence 

It's not uncommon for vulnerability factors to invade an 

organization network and leak delicate information. In any 

case, their activities can likewise stay covered up for a 

significant stretch, and ordinarily they utilize advanced 

malware to utilize organization resources. traffic analysis 

allows the discovery of any dubious increment in outbound 

traffic flow. Packet sniffers help in recognizing a increase in 

the traffic, endeavors at network intrusion, and empower 

further assessment and removal of security vulnerabilities. 

They help in checking the status of Wide Area Network and  

security systems. packet sniffers likewise help in regulatory 

consistence documentation by logging the entire perimeter 

and endpoint traffic. In addition, with packet sniffers, 

security teams can confirm the adequacy of their security 

arrangement comprising of a few firewalls, web filters, 

WAF, IPS/IDS frameworks, and many more. 

V. DRAWBACKS OF PACKET SNIFFERS 

1) Configuring your network device to read all network 

packets that arrive, which might contain torjan horses 
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you might also open doors to the intruders  access to 

your confidential data and network files 

2) The fundamental impediment of such packet sniffer is 

that it can't decode the SSL traffic without recovering 

the server certificate. 

VI. BEST PRACTICES OF PACKET SNIFFERS 

With your packet sniffer close by and your NIC set to 

promiscuous mode, you'll be making excellent progress so 

far with packet capture. In any case, while a large number of 

the advantages of packet sniffing will come to use, there are 

sure prescribed procedures to follow in the event that you 

need to harvest the full outcomes and shield your 

organization from security infringement. To get most of 

your packet sniffer, ensure you: 

1) Know the Basics:- To examine network traffic, you 

should see how systems networking functions. Indeed, 

some packet sniffers will separate information and offer 

dashboards loaded with understanding, yet thinking 

about the kinds of network traffic on a good network, 

for example, the Address Resolution Protocol (ARP), 

for correspondence, and the Dynamic Host 

Configuration Protocol (DHCP), for network 

management. You have to recognize what you need the 

packet sniffer to gather and have a overall thought of 

what's ordinary and what's not. With a base-level 

comprehension of network traffic, you can help 

guarantee you're assessing the correct mass of packets. 

equip yourself with the essential standards and you'll be 

set for progress. 

2) Copy Cautiously:- Every packet contains a header 

distinguishing its source and destination just as a 

payload—the term used to depict the information of the 

packet. An essential packet sniffer will copy the 

payload and headers of all packet going on the network. 

In the event that the packet payload isn't encoded, 

individuals from your IT team can get to sensitive 

business information, making the ways for a plenty of 

potential security risks. To assist you with securing 

your network and abstain from placing sensitive data in 

peril, numerous parcel sniffers can be set to copy just 

the header data. More often than not, this is the main 

data you'll have to perform network performance 

analysis. 

3) Track Storage Space:- Regardless of whether you're just 

catching packet headers, putting away every packet can 

devour a lot of your storage space. In the event that you 

can gather a brief info of network use over a set period, 

state a couple of days, it's ideal to copy each 10th or 

20th packet as opposed to replicating each and every 

one. This is known as packet sampling, and it's a 

practice generally used to portray network traffic. 

Packet sampling works by utilizing randomness in the 

sampling cycle to forestall synchronization with any 

occasional patterns in the traffic. While this technique 

for network characterization isn't 100% exact, it's an 

answer with quantifiable precision. 

4) Crack the Data. A portion of the network information 

accumulated by a packet sniffer will be encoded. To 

gather the full advantages of the packet capture 

procedure, pick a packet sniffer ready to crack this 

administrative data and just as concentrate on other 

important information, for example, the fluctuating port 

numbers between which the packets travel. This data 

will assist you with creating a more strong analysis of 

your network traffic. 

VII. PACKET SNIFFER TOOLS 

It's no doubt that bottlenecks, downtime, and other normal 

network execution issues can incomprehensibly affect the 

end-user experience and put efficiency on pause, eventually 

cutting into your network's primary concern. Getting to the 

underlying cause of issues is a main concern for every 

sysadmin. This is the place packet sniffers, otherwise called 

network sniffers or network analyzers, become an integral 

factor. With the correct packet sniffer, you'll be well-

prepared to catch and analyze network traffic, helping you 

recognize the reason for network performance issues and 

keep them from repeating in the future. 

A. Wireshark 

Wireshark is the world's best network traffic analyzer, and a 

necessary tool for any security expert or administrative 

executive. This free programmed software lets you break 

down network traffic progressively, and is regularly the best 

apparatus for investigating issues on your network.  

Basic issues that Wireshark can help investigate 

incorporate dropped packets, inactivity issues, and harmful 

activities on your network. It lets you put your network 

traffic under observation, and gives tool to break and 

penetrate down into that traffic, focusing it on the root issue. 

administrators use it to distinguish flawed network nodes 

that are dropping packets, latency issues brought about by 

machines steering traffic most of the way around the globe, 

and information exfiltration or in any event, hacking 

endeavors against your organization. Wireshark is an 

incredible asset that requires sound information on network 

basics. For most present day ventures, that implies 

understanding the TCP/IP stack, how to peruse and decipher 

packet headers, and how routing, port forwarding, and 

DHCP work. 

1) What does Wireshark do? 

Given the enormous volume of traffic that crosses in a run 

business network, Wireshark helps to assist you with 

filtering the traffic that's what make it particularly valuable. 

Catpture filters will gather just the kinds of traffic you're 

keen on, and display filters will assist you with focusing in 

on the traffic you need to assess. The network protocol 

analyzer gives search options, including customary 

articulations and color featuring, to make it simple to 

discover what you're searching for. Some of the time the 

most ideal approach to discover peculiar traffic is to catch 

everything and set up a benchmark. Wireshark is the 

frequently utilized packet sniffer on the planet. Like some 

other packet sniffer, Wireshark completes three things:  

packet Capture: Wireshark tunes in to an network 

traffic continuously and afterward snatches whole floods of 

traffic – potentially a huge number of packets all at once. 

Filtering: Wireshark is equipped for cutting and 

dicing the entirety of this arbitrary live information utilizing 
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filtering. By applying a filter, you can get only the data you 

have to see.  

Visualization: Wireshark, similar to any great 

packet sniffer, permits you to make a plunge directly into 

the extremely center of an network packet. It likewise 

permits you to picture whole discussions and network 

streams.Wireshark is a protected tool utilized by 

government offices, instructive foundations, enterprises, 

private companies and philanthropies the same to investigate 

network issues. Moreover, Wireshark can be utilized as a 

learning device.  

Wireshark captures traffic and converts that binary 

traffic into intelligible human understandable format. This 

makes it simple to recognize what traffic is crossing your 

network, its amount, how as often as possible, how much 

latency there is between how many bounces, etc.  

While Wireshark underpins in excess of 2,000 

network protocols, a considerable lot of them obscure, 

extraordinary, or old, the cutting edge security expert will 

discover examining IP packets to be of most prompt 

handiness. Most of the packets on your organization are 

probably going to be TCP, UDP, and ICMP. 

2) How to:- 

 
Fig. 1: wireshark interface 

In the event that you have promiscuous mode 

empowered—it's empowered of course—you'll additionally 

observe the wide range of various packets on the network 

rather than just packets routed to your network adapter. To 

check if promiscuous mode is empowered, click Capture > 

Options and confirm the "Empower promiscuous mode on 

all interfaces" checkbox is enacted at the lower part of this 

window. Click the red "Stop" button close to the upper left 

corner of the window when you need to quit catching traffic. 

 
Fig. 2: Wireshark scanned tarffic 
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On the off chance that there's nothing fascinating 

on your own network to assess, Wireshark's wiki has you 

covered. The wiki contains a page of test catch files that you 

can stack and review. Snap File > Open in Wireshark and 

peruse for your downloaded record to open one.You can 

likewise spare your own capture in Wireshark and open 

them later. Snap File > Save to spare your caught packets.  

 
Fig. 3: Filtering Packets 

The most essential approach to apply a filter is by 

composing it into the filter box at the highest point of the 

window and clicking Apply (or squeezing Enter). For 

instance, type "dns" and you'll see just DNS packets. At the 

point when you begin writing, Wireshark will help you 

autocomplete your filter. 

 
Fig. 4: filtering packets 

You can likewise click Analyze > Display 

Filters to choose a filter from among the default filters 

remembered for Wireshark. From here, you can add your 

own custom filters and spare them to handily get to them 

later on.Another intriguing thing you can do is right click a 

packet and select Follow > TCP Stream. You'll see the full 

TCP discussion between the client and the server. You can 

likewise click different protocols in the Follow menu to see 

the full discussions for different protocols, if relevant. Close 

the window and you'll discover a filter has been applied 

consequently. Wireshark is showing you the packets that 

make up the discussion. 
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Fig. 5: inspecting packets 

click a packet to choose it and you can see drop 

down to see its details. You can likewise make filters from 

here — right click one of the information of packet and 

utilize the Apply as Filter submenu to make a filter based on 

it. 

 
Fig. 6: inspecting packets 

Wireshark is an extremely powerful tool, and this is 

just  the surface of what you can do with it. Many security 

Professionals use it to debug network 

protocol implementations, examine security problems and 

inspect network protocol internals. 

B. Tcpdump 

tcpdump is an information network packet analyzer system 

program that runs under an command line interface. It 

permits the end user to show TCP/IP and different packets 

being sent or gotten over an network to which the system is 

attached. Distributed under the BSD license,tcpdump is free 

tool.  

Tcpdump tool works on most of  the Unix-like 

working operating system: Linux, Solaris, FreeBSD, 

DragonFly BSD, NetBSD, OpenBSD, OpenWrt, macOS, 

HP-UX 11i, and AIX. In those systems, tcpdump utilizes the 

libpcap library to catch packet. The port of tcpdump for 

Windows is called WinDump; it utilizes WinPcap, the 

Windows variant of libpcap. 

1) What does Tcpdump does? 

tcpdump captures the contents of network packets. It can 

interpret packets from an network interface card or from a 

formerly made spared packet document. tcpdump can write 

packets to output or a record.  

It is likewise conceivable to utilize tcpdump for the 

particular motivation behind blocking and showing the 

interchanges of another end user or system. A end user with 

the vital advantages on a framework going about as a router 

or gateway through which decoded traffic, for example, 

Telnet or HTTP passes can utilize tcpdump to see login IDs, 

passwords, the URLs and information of sites being seen, or 

some other decoded data.  

The end user may alternatively apply a BPF-based 

filter to restrict the quantity of packets seen by tcpdump; this 
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delivers the output more usable on networks with a high 

volume of traffic. 

2) How to use:- 

To install the tool on Ubuntu/Debian OS  

Command:- apt install tcpdump 

To capture the packets of current network interface 

Command:- sudo tcpdump 

This will catch the packets from the current interface of the 

network through which the computer is connected with the 

web. 

 
Fig. 7: captured packets of current network interface 

Command:- sudo tcpdump -c 4 -i wlo1  

This command captures the packets from wlo1 network interface. 

 
Fig. 8: captured packets from a specific network interface 

Command :- sudo tcpdump –D will display all the interfaces that are available in the system. 
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Fig. 9: display all available interfaces 

Command :- sudo tcpdump -w captured_packets.pcap -i wlo1 will now output all the captures packets in a file named as 

captured_packets.pcap. 

 
Fig. 10: save captured packets into a file 

Command:- sudo tcpdump -n -i wlo1 will now capture the packets with IP addresses. 

 
Fig. 11: capture packets with ip address 

C. Ettercap 

An free and open source network security tool Ettercap is 

for man-in-the-middle attacks on LAN. It tends to be 

utilized for system network protocol analysis and security 

evaluating. It runs on different Unix-like operating system 

including Linux, Mac OS X, BSD and Solaris, and on 

Microsoft Windows. It is fit for blocking traffic on an 

network node, catching passwords, and leading active 

eavesdropping against various normal protocols. 

1) What does ettercap does? 

Ettercap works by placing the network interface into 

promiscuous mode and by ARP poisoning the target 

machines. Accordingly it can go about as a 'man in the 

middle' and release different attacks on the people in 

question. Ettercap has plugin module support so that can be 

stretched out by adding new modules. 

Ettercap underpins dynamic and latent analyzation 

of numerous protocols (counting encoded ones) and gives 
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numerous highlights to arrange and have investigation. 

Ettercap offers four methods of activity:  

IP-based: packets are separated dependent on IP 

source and destination.  

MAC based: packets are shifted dependent on 

MAC address, helpful for sniffing connections through an 

gateway.  

ARP-based: the attack ARP poisoningis used to 

sniff on an switched LAN between two hosts (full-duplex).  

PublicARP-based: the attack ARP poisoning is 

used to sniff on a switched LAN from a attacking host to 

every single other host (half-duplex). 

2) How to use:- 

In Kali, click on "Applications," at that point "Sniffing and 

Spoofing," trailed by "ettercap-graphical." Alternatively, 

click on the "Show Applications" choice in the harbor, at 

that point look for and select "Ettercap."  

When it fires up, you should end up on the Ettercap 

primary screen. You'll see the creepy Ettercap logo, and a 

couple of drop-down menus to begin the attack from. In the 

following stage, we'll begin investigating the "Sniff" menu. 

At this point, ensure you have a active connection with the 

network before you proceed. 

 
Fig. 12: ettercap interface 

click on the "Sniff" menu thing, and afterward 

select "unified sniffing." another window will open 

requesting that you select which network interface you need 

to sniff on. You should choose the netsork interface that is 

right now connected with the network you're attacking.  

Presently, you'll see some content affirming that 

sniffing has begun, and you'll have the option to get to 

further developed menu alternatives, for example, Targets, 

Hosts, Mitm, Plugins, and so on Before we begin utilizing 

any of them, we'll have to distinguish our target on the 

network. 

 
Fig. 13: network interface to sniff 
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Fig. 14: network interface to sniff 

To discover the device we need to attack on the 

network, Ettercap has a couple of features at its disposal. To 

start with, we can do a basic sweep for has by clicking 

"Hosts," at that point "scan for hosts." A sweep will execute, 

and after it completes, you can see the subsequent hosts 

Ettercap has recognized on the network by clicking "Hosts," 

at that point "Hosts list."  

We would now be able to see a rundown of targets 

we've found on the network. Need to perceive what they're 

doing or limited down the traget? click "View," at that point 

"connections" to begin snooping around on connections.  

Once in the Connections see, you can filter the 

connections by IP address, sort of connection, and whether 

the connection is open, shut, active, or executed. This gives 

you a ton of snooping power, which can be increased by 

tapping the "View," at that point "Resolve IP addresses." 

This implies Ettercap will attempt to determine the IP 

address to it observes different devices on the network 

connecting with. 

 
Fig. 15: identify host on network 

Since we've distinguished our target's IP address, 

it's an ideal opportunity to add them to a list. When we do 

this, we'll be disclosing to Ettercap that we need to assign 

that IP address as one we need to claim to be, so that we're 

getting messages from the router that were intended to be 

sent to the target.  

Return to the "Hosts" screen, and select the IP 

address of the target you need to target. click the IP address 

to feature it, at that point click on"Targets," trailed by 

"Target list," to see a rundown of host devices that have 

been focused for ARP spoofing. 
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Fig. 16: choose target in found hosts on network

click on the "Mitm" menu, and select "ARP 

poisoning." A popup will open, and you'll choose "Sniff 

remote connections" to start the sniffing attack. Once this 

attack has started, you'll have the option to block login 

certifications if the client you're focusing on enters them 

into a site that doesn't utilize HTTPS. This could be a router 

or a gadget on the network or even a site that utilizes 

helpless security.  

To attempt another attack, you can tap on 

"plugins," at that point "load plugin," to show the plugin 

menu. In the event that you select the DOS attack, it will 

start dropping the packet sent this target, removing their web 

access. 

 
Fig. 17: launch attack 

 
Fig. 18: capturing passwords from test websites 
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A site that is incredible for testing is aavtain.com, 

which intentionally utilizes awful security so you can catch 

credentials. On the target device, explore to aavtrain.com. 

When it loads, you'll see a login screen you can enter a fake 

login credentials into. Enter a username and secret phrase, at 

that point hit "Submit." If Ettercap is effective, you should 

see the login and secret key you composed show up on the 

attackers screen! . In this outcome above, we can see that 

Ettercap effectively ARP poisoned the target and caught a 

HTTP login request the target was shipping off an uncertain 

site. 

D. Network Miner 

An open source tool NetworkMiner is Network Forensic 

Analysis Tool (NFAT) for Windows yet it works in 

Linux/Mac OS X/FreeBSD. NetworkMiner can be utilized 

as a network sniffer/packet catching software to identify 

working systems, sessions, hostnames, open ports and so 

forth without putting any traffic on the network. 

NetworkMiner can likewise parse PCAP documents for 

offline examination and to recover/reassemble 

communicated records and declarations from PCAP 

documents.  

NetworkMiner makes it simple to perform 

progressed Network Traffic Analysis (NTA) by giving 

extricated  relics in an instinctive UI. The manner in which 

information is introduced not just makes the examination 

less difficult, it additionally spares important time for the 

examiner or forensic agent.  

NetworkMiner has, since the principal release in 

2007, become a famous apparatus among incident response 

groups just as law requirement. NetworkMiner is today 

utilized by network and organizations everywhere on the 

world. 

1) What does network miner does? 

Wireshark is the default goto software for examining caught 

network traffic for most network engineers. In any case, 

there are a couple of other free and open source choices that 

are at times disregarded, one of which is NetworkMiner. 

Numerous clients/users go to NetworkMiner with regards to 

removing information, for example, documents or 

credentials from pcap records. You can settle such 

undertakings with Wireshark as well, however 

NetworkMiner will spare you time and extra you some 

manual work. Indeed, NetworkMiner consequently separates 

records from conventions like FTP, TFTP, HTTP, HTTP/2, 

SMB, SMB2, SMTP, POP3, and IMAP when a pcap 

document is opened. 

user credentials, for example, usernames, 

passwords and hashes that NetworkMiner identifies are 

totally positioned under the "credentials" tab. The 

conventions and information structures from which 

NetworkMiner can extricate crendentials incorporate FTP, 

HTTP treats, HTTP POST demands, IMAP, Kerberos 

hashes, MS SQL, NTLM hashes, POP3, RDP treats, SMTP, 

SOCKS and a couple of something else.NetworkMiner is a 

host driven network investigation software with sniffing 

abilities. Host driven implies that it sorts information 

concerning the hosts instead of the packets 

2) How to use? 

The steps needed to running NetworkMiner for it to 

understand the network traffic: 

1) On the off chance that you are running Windows 7 or 

Windows 8, you should run NetworkMiner.exe with 

administrative permission.  

2) Select the network interface for which the information 

must be caught. 

 
Fig. 19: network miner interface 



Review On Packet Sniffer Tools 

 (IJSRD/Vol. 8/Issue 9/2020/043) 

  

 All rights reserved by www.ijsrd.com 197 

Of course, the Hosts tab is chosen. You can sort 

hosts by IP address, MAC address, hostname, Operating 

System and so forth. 

 
Fig. 20: host tab 

click on the start button to start sniffing. 

 
Fig. 21: started sniffing 

On the Hosts tab, you will see a rundown of hosts 

associated with the network. You can extend any host to see 

itemized data like its MAC address, hostname, Operating 

System, TTL, Open ports, packets sent, gotten and so on A 

decent network administrator consistently has a review of 

what information is being communicated to and from his 
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network. The rundown of hosts will give you a superior 

thought of what kind of network traffic you are utilizing. 

On the off chance that you locate a suspicious host, 

you can generally hinder it through your firewall. The 

firewall should be the one from where all network traffic 

passes prior to arriving at the destination In the event that 

you block the host on your firewall, it might be hindered on 

your system.  

On the off chance that you are utilizing some other 

network sniffer that can spare the PCAP record, 

NetworkMiner can likewise investigate the PCAP document 

and let you experience the information offline.  

One smart component of NetworkMiner is that it 

can reassemble the records sent through the network and 

arrange afterward download them in complete structure. 

This should be possible from the Files tab. You can likewise 

catch and download pictures from the network traffic from 

the Images tab.  

Sending passwords in clear can be exceptionally 

hazardous for the network overall. On the off chance that 

you need to check if any host is sending passwords in clear 

content, you can see it in the Credentials tab. 

 
Fig. 22: captured data packets and their information 

VIII. CONCLUSION 

In this paper several prospects about packet sniffer tools like 

Wireshark, Tcpdump, Ettercap and NetworkMiner and some 

basic features which we can gather some information using 

open source tools. And by using some vulnerable website, 

Mail-id to collect basic information by using packet sniffer 

tools. Also we can use this tools in cyber security and 

ethical Hacking to gather information. 
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